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Kalibrierung eines 1200L/mm-DADOS-Spektrums des  

Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

1. Der Bedeckungsveränderliche VV Cephei 

1.1 Das Bedeckungsereignis 2017-2019 
 

VV Cep (HD 208816) ist ein bedeckungsveränderlicher Stern mit einer Umlaufzeit von 20,4 Jahren1. Mit 4,9 

mag scheinbarer Helligkeit ist er zudem ein relativ helles, rötlich leuchtendes Objekt im Zentrum des 

Sternbildes Cepheus, ca. 4900 Lichtjahre von der Erde entfernt2. Die Komponente VV Cep A ist als M2-

Überriese einer der größten Sterne in der Galaxis, der Sternradius beträgt zwischen 1050 und 1900 

Sonnenradien, die Masse bis zu ca. 20 Sonnenmassen.  

Der M2-Überriese füllt sein Roche-Volumen aus, wenn der ca. 8 Sonnenmassen schwere Begleiter, ein heißer 

B-Stern, den Überriesen im Periastron nahesteht. Der B-Stern vom Typ B0 bis B2 ist ein Hauptreihenstern mit 

ca. 25000K Oberflächentemperatur.  Im System findet ein Massentransfer 

vom Überriesen zum B-Stern statt. Es bildet sich eine rotierende, 

leuchtende Materiescheibe aus, die weniger als 1/18 des Durchmessers der 

Photosphäre des Überriesen ausgedehnt ist und zudem keine sphärische 

Symmetrie aufweist3.    

Der B-Stern pflügt durch den Wind des M2-Überriesen und bildet an der 

Vorderseite eine bogenförmige Schockfront aus, die sich stark aufheizt wird 

und Licht emittiert.  

Der M2-Überriese verliert durch einen 20 

km/s erreichenden Sternwind ca. 1.5 ∙

10−6 Sonnenmassen pro Jahr4.  

  

 

 
1 "Giants of Eclipse: The zeta Aur Stars and Other Binary Systems" Springer 2015, by Ph. Bennett & Wendy Hagen Bauer, 

S. 87 
2 https://en.wikipedia.org/wiki/VV_Cephei 
3 http://ibvs.konkoly.hu/cgi-bin/IBVS?6156 
4 Bennet, P. D. (2010). "Chromospheres and Winds of Red Supergiants: An Empirical Look at Outer Atmospheric 
Structure". ASP Conference Series 425: 181. arXiv:1004.1853. Bibcode:2010ASPC..425..181B 
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Der aktuelle Bedeckungszyklus findet vom 15.8.2017 

bis Mitte Mai 2019 statt. Dabei scheint der Be-Stern 

durch die dünne Chromosphäre/Photosphäre des 

M2-Überriesen. Die Bedeckung der Gasscheibe des B-

Sterns durch die halbtransparente Atmosphäre des 

M2-Überriesen wirkt dramatisch auf das Spektrum 

des B-Sterns aus.  

Die Bedeckung dauert rund 673 Tage5. 

𝑡1 2017-08-15 

𝑡2  ……… 
𝑡𝑚 MID ca. 2018-06-05 

𝑡3 ca. 2019-02 

𝑡4 ca. 2019-05 

 

 

1.2 Definition der Messgrößen 
Im Langzeitmonitoring6 sind folgende Messgrößen bei der H-Linie zu ermitteln:  

H-Äquivalentbreite EW(V) von (ca. 6551Å bis H-Absorptionsminimum) 

H-Äquivalentbreite EW(R) von (H−Absorptionsminimum bis ca. 6572Å) 

Intensität des H V-Peaks 

Intensität des H R-Peaks 

V/R-Verhältnis der H−Linie 

Heliozentrische Radialgeschwindigkeit HRV des H-Absorptionsminimums  

 

 
5 http://www.astronomie.de/astronomische-fachgebiete/spektroskopie/projekte-kampagnen/das-vv-cephei-projekt/ 
6 http://ibvs.konkoly.hu/cgi-bin/IBVS?6156 
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Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

2. Der vorliegende Datensatz: VV Cep und NeArH-Referenzspektrum 

 

Aufnahmen von VV Cep (je 300s belichtet, CCD-Kamera ST-8300M), eine Aufnahme des RelcoSC480 

Neon/Argon/Wasserstoff-Referenzspektrums, ein Flatfield, beide jeweils 300s belichtet. Die Sternspektren 

wurden im Bereich des 35m-Spalt aufgenommen. Teleskop: Celestron 14 EdgeHD. Referenzspektrum und 

Flatfieldspektrum wurden mit dem Alpy Calibration Module aufgenommen.  

https://www.shelyak.com/produit.php?id_produit=92&id_rubrique=17 

Folgendes ist bei der Aufnahme grundsätzlich zu beachten: 

Referenzspektren und Objektspektren müssen zeitlich nah beieinander 

aufgenommen werden. Grund: Der Spektrograf dehnt sich aus oder zieht 

sich zusammen, wenn sich die Außentemperatur ändert. Deshalb lässt 

man den DADOS und das Teleskop zunächst eine halbe Stunde auskühlen, 

bevor man beginnt. Zuerst wird ein Referenzspektrum aufgenommen, 

dann eine Serie von Objektspektren 

und zum Schluss wieder ein 

Referenzspektrum. Ausnahme: Im 

vorliegenden Fall wurde nur ein 

Referenzspektrum am Ende der Serie 

aufgenommen. Im niedrig auflösenden 

Anwendungsbereich ist das auch völlig 

ausreichend, weil thermische Driften 

in der vorliegenden Serie nicht zu erkennen sind. Außerdem sollte der 

Spektralfaden bereits möglichst exakt horizontal orientiert sein, blaues Ende links, rotes rechts. 

http://www.schuelerlabor-astronomie.de/
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Kalibrierung eines 1200L/mm-DADOS-Spektrums des  

Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

2.1 Vorbereitung der Spektren: Spektren beschneiden, um Datenmenge zu begrenzen  
 

Referenz- und Sternspektren liegen vorbereitet in diesem beschnittenen Bildformat vor. Das Ausschneiden 

und Abspeichern erfolgte in unserem Beispiel mit MaxIm DL.  

Wichtig ist hierbei, dass alle Spektren gleich ausgeschnitten werden. Andernfalls stimmt die 

Wellenlängenkalibrierung nicht. 

Wo liegt der Spektralfaden VV cep in Bezug auf das Referenzspektrum? Zur Ansicht – nicht zur Auswertung – 

wurden beide Spektren überlagert. Der Spektralfaden von VV Cep hätte bei der Aufnahme besser etwas weiter 

unten platziert werden sollen, da nun Der Himmelshintergund oberhalb des Spektrums etwas knapp ist. 

 

Hinweis: Die BASS 32-Bit-Version ist nicht in der Lage größere Datenmengen im RAM zu verwalten. 10 Spektren 

à 16MB Speichervolumen sind bereits zu viel. Für diese Version wird definitiv empfohlen, die Spektren vor der 

Weiterverarbeitung in BASS in Bezug auf die Höhe zu beschneiden. Dies muss jedoch für alle Spektren in selber 

Weise erfolgen! Jedes Programm zur Steuerung einer CCD-Kamera sollte in der Lage sein, dies vorzunehmen. 

Hinweis: Die BASS 64-Bit-Version ist hingegen in der Lage, größere Datenmengen zu verwalten. Tritt dennoch 

ein Speicherfehler auf, sollten die Spektren vorher beschnitten werden.  

Zunächst wird der Spektralfaden in der Höhe etwas beschnitten. Da VV Cep auf dem 35m-Spalt liegt, wird 

nur der untere Spektralfaden ausgeschnitten.  

Hinweis: Der Spektralfaden darf nicht zu eng ausgeschnitten werden. Ober- und unterhalb muss noch Raum 

sein, um später den Bereich des Himmelshintergrundes zu definieren.  

Hinweis: Legen Sie vorher eine Kopie des Datensatzes an.  

http://www.schuelerlabor-astronomie.de/
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Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

Ausschneiden des unteren Spektrums, hier mit der Funktion Crop in MaxIm DL: 

 

Referenzspektrum NeArH, 300s, DADOS, 1200 L/mm, Spalt 35m 

 

 

Flatfieldspektrum einer internen Halogenlampe, 300s, DADOS, 1200 L/mm, Spalt 35m 

 

 

Vier Spektren von VV Cep, je 300s mit Darkframe-Korrektur, 1200 L/mm, Spalt 35m 

 

http://www.schuelerlabor-astronomie.de/
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Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

3. BASS starten 
 

Dieses Tutorial setzt voraus, dass Rohspektren und Kalibrierspektren im Ordner C:/astrobodger/VV Cep/2015-

12-31/…. im Format FIT vorliegen. Diese wurden mit einem Celestron 14 EdgeHD-Teleskop und MaxIm DL 

aufgenommen; bei der Aufnahme wurden automatische Darkframes subtrahiert.  

  

Start der aktuellen Version BASSProject.exe im Ordner C:/astroboger 

Das leere Arbeitsfenster eines neuen Projekts in der BASS 64-Bit-Version: 

 

BASS arbeitet mit sogenannten „Projekten“, bei denen alle verwendeten 2D-Rohspektren, Ergebnisse und 

Beschriftungen gespeichert werden an einem festen Speicherort, C:/astrobodger. Projekte werden im Format 

.bass abgespeichert. BASS meldet sich, wenn Teile des Projekts (neue oder geänderte Spektralprofile) noch 

nicht gespeichert wurden und fordert dann dazu auf. Änderungen an vorhandenen oder neu erzeugte 

Spektralprofile werden im Format .fit (bzw. .dat) abgespeichert. Das FITS-Format ist umfangreicher als das 

DAT-Format, weil zusätzlich zu den Datenzeilen x,y auch alle wichtigen sonstigen Informationen gespeichert 

werden: Datum, Uhrzeit, Belichtungszeit, Aufnahmeort, etc.  

Hinweis: Der Begriff „2D“ bedeutet in der Spektroskopie, dass es sich um ein Foto des Spektrums handelt, so 

wie man es am Teleskop aufnimmt. „1D“ ist der aus dem Foto erzeugte Spektralprofil, welches nur ein 

Datensatz mit zwei Spalten ist: x =Position entlang des Sensors, y=Intensität in y-Richtung aufsummiert.  

http://www.schuelerlabor-astronomie.de/
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4. Spektren mit Flatfield kalibrieren und stacken ohne Alignment 
 

➔   Stack Images 

➔ Light Images öffnen  

➔ [No alignment] 
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➔ Other Images auswählen: Flat.fit 

 

➔ Stack 
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Kalibrierung eines 1200L/mm-DADOS-Spektrums des  

Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

➔ Ergebnis: Summenbild von vier VV Cep-Spektren, mit Flatfieldkorrektur, aber ohne Subtraktion des 

Himmelshintergrundes 

  

➔ Image Strip View -> Raw Image 50% 

➔   Speichern des Projekts unter dem Namen C:/astrobodger/VV Cep/2015-12-31/VV Cep.bass 

Erläuterung: Die x-Achse („Pixels uncalibrated“) entspricht der Pixelposition in horizontaler x-Richtung auf dem 

Foto. Dieser Pixelwert muss in einen Wert für die Wellenlänge  (Lambda) umgerechnet werden. Die 

Ermittlung des funktionalen Zusammenhangs zwischen Pixelposition (x) und Wellenlänge () in Form eines 

Polynoms höheren Grades =f(x) bezeichnet man als Wellenlängenkalibrierung. 

Die y-Achse („Flux“) gibt die Intensität an einer bestimmten Pixelposition im 1D-Spektralprofil an. Diese 

Intensitätskurve wird in diesem Tutorial kalibriert: Beseitigung des Pseudokontinuums (Normierung auf „1“).  

  

http://www.schuelerlabor-astronomie.de/
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5. Voreinstellungen vornehmen 
 

➔   Project Chart Settings: Hier alle Daten eingeben.  

➔ Main Title und Sub Title speichern 

 

 

Chart width: CFG-Medion-Notebooks ca. 1150 / Chart height: 450 (hängt von der Größe des Bildschirms ab) 
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Chart width: CFG Medion-Notebooks ca. 1150 / Chart height: 450 (hängt von der Größe des Bildschirms ab) 

… und am Ende das Anwenden und Speichern nicht vergessen → Apply → Ok 
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➔  Speichern des gestackten Bildes: C:/astrobodger/VV Cep/2015-12-31/VV Cep.fit 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

➔   Speichern des Projekts unter dem Namen C:/astrobodger/VV Cep/2015-12-31/VV Cep.bass 

 

 

 

 

 

 

 

 

 

➔ Prüfen, ob Projekt korrekt gespeichert ist: New Projekt  ➔Open Project   
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6. Referenzspektrum öffnen 

➔  Open Image Files    

➔ Relco SC480 NeArH.fit  

                                   

        #01 (Blau): Spektrum VV Cep, #02 (Grün): Referenzspektrum der NeArH-Lampe Relco SC480. 

➔  Speichern des Projekts unter dem Namen C:/astrobodger/VV Cep/2015-12-31/VV Cep.bass 
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Jetzt Positionen tauschen: Das Referenzspektrum muss an Position 1 gelangen. 

 

➔ #02 aktivieren ➔ Rechte Maustaste  Sequence ➔ 01 

 

 

 

 

Nach dem Tausch der Position ist dies die neue Reihenfolge:  
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7.  Sternspektrum und Referenzspektrum horizontal ausrichten. 
 

Zuerst werden die Captions (Namen) der Scans geändert 

 

➔ Relco SC480 NeArH.fit umbenennen in Relco SC480 NeArH 

➔ Spektrum Stack4Images umbenennen in VV Cep  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Rotate/Tilt correction 

 

➔ Spektrum 02: VV Cep aktivieren 

➔ Image ➔ Rotate/Tilt correction 

 

 

 

 

 

 

 

 

 

 

 

http://www.schuelerlabor-astronomie.de/
mailto:Bernd.Koch@astrofoto.de


 

            
 Schülerlabor Astronomie des Carl-Fuhlrott-Gymnasiums, Jung-Stilling-Weg 45, 42349 Wuppertal 
www.schuelerlabor-astronomie.de | Kontakt: Dipl.-Phys. Bernd Koch | Bernd.Koch@astrofoto.de              17 

 

 
Kalibrierung eines 1200L/mm-DADOS-Spektrums des  

Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

➔ Rotate/Tilt ➔ Select Region, Tilt Image, Emission, Apply to all open images wählen. 

➔ Dann mit der Maus einen Rahmen aufziehen entlang des Spektrums. 

➔ Apply ➔ Close 

Nun sind alle Spektren gleichermaßen um einen Winkel von 0.06° horizontal ausgerichtet.  

Eine Smile/Slant-Korrektur wird hier nicht vorgenommen. 

➔   Abspeichern gedrehten beiden Spektren: Save the selected image strip (selbe Namen)  

  

➔  Speichern des Projekts:  Unter dem selben Namen VV Cep.bass 
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Kalibrierung eines 1200L/mm-DADOS-Spektrums des  

Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

8. Auswahl des Scanbereichs für Spektrum und Himmelshintergrund 
➔ Sternspektrum #02 auswählen 

➔ Image Strip View: 100% 

➔ Selection ➔ Region Selection Tool  

 

 

 

 

 

 

Es erscheint das Menüfenster Region Selection Tool.  

➔ Active Binned Region (Sternspektrum definieren) 

➔ Ziehe nun einen Rahmen innerhalb des Spektrums auf 

➔ Update 

 

 

 

 

 

 

 

 

 

➔ Verändere die Werte für Y Start und Y End, bis der Rahmen das Spektrum in nahezu voller Höhe 

umfasst. Die Breite wird automatisch angepasst. 

 

➔ Update ➔   Bildschirm-Refresh ➔ Close 

 

Hinweis: Unklar ist, inwieweit die Statistik der aktiven Binning-Zone hinsichtlich der Erzielung eines optimalen 

SNR innerhalb des Scanbereichs verwendet werden kann. 

 

(Rahmen aufziehen) 
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Kalibrierung eines 1200L/mm-DADOS-Spektrums des  

Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

Nun werden die beiden Regionen für den Himmelshintergrund oben/unten definiert: 

Manuelle Festlegung der beiden Himmelshintergrundbereiche oben/unten: 

➔ Substraction Region 1 (für Himmel „oben“, also oberhalb des Sternspektrums) 

➔ Rahmen aufziehen für Himmel „oben“ 

 

➔ Update. Der Rahmen wird automatisch über die ganze Breite aufgezogen. 
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Kalibrierung eines 1200L/mm-DADOS-Spektrums des  

Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

➔ Substraction Region 2 (Himmel „unten“, also unterhalb des Sternspektrums) 

➔ Rahmen aufziehen für Himmel „unten“ 

 

       Und das ist das Ergebnis der Festlegung der Bereiche:  

 

➔ Update ➔ Close 

➔   Bildschirm-Refresh nicht vergessen!! 

Nun wird NUR die „Active Binning Zone“, also der Bereich des Sternspektrums VV Ceps, der gescannt wird, auf 

das Referenzspektrum übertragen: 

➔ Mit linker Maustaste in das Spektrum 01: Relco SC480 NeArH aktivieren 

➔ Mit rechter Maustaste in das Spektrum 01: Relco SC480 NeArH klicken 

➔ Copy Active Binned Region from 

➔ 02: VV Cep 
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Kalibrierung eines 1200L/mm-DADOS-Spektrums des  

Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

 

Ergebnis: Es sind alle benötigten Bereiche in beiden Spektren definiert:  

 

➔   Speichern des Projekts unter dem selben Namen VV Cep.bass 

 

Das blaue Spektrum von VV Cep  ist das Resultat folgender Operation: 

Intensität des Spektrums von VV Cep = Intensität der Active Binning-Zone – Intensität (Himmel oben + Himmel unten)/2  

  

Himmel oben 
Referenzspektrum 

Spektrum Capella 
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Kalibrierung eines 1200L/mm-DADOS-Spektrums des  

Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

9. Einzelne Spektralbereiche genauer betrachten  
 

➔ Beispiel: H-Linie 

➔ Ziehe mit der linken Maustaste einen Bereich von ca. 1400px bis 2600px auf 

➔   Crop X-Axis Range 

 

  

 

 

 

 

 

 

 

 

➔ Apply ➔ Close ➔ Ok 

 

➔ Zurück zur Gesamtansicht 

 

➔  Crop X-Axis Range  

 

➔ Turn off cropping ➔ Apply ➔ Ok 

 

➔ Projekt speichern 

 

  

http://www.schuelerlabor-astronomie.de/
mailto:Bernd.Koch@astrofoto.de


 

            
 Schülerlabor Astronomie des Carl-Fuhlrott-Gymnasiums, Jung-Stilling-Weg 45, 42349 Wuppertal 
www.schuelerlabor-astronomie.de | Kontakt: Dipl.-Phys. Bernd Koch | Bernd.Koch@astrofoto.de              23 

 

 
Kalibrierung eines 1200L/mm-DADOS-Spektrums des  

Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

10. Wellenlängenkalibrierung 

10.1 Das Spektrum der RELCO SC480 NeArH Referenz 
Die Wellenlängendatei befindet sich im Ordner c:/astrobodger/Reference/RelcoSC480.dat 

10.2 Wellenlängenkalibrierung des Spektrums des Referenzspektrums 
Dies sind die hier verwendeten acht Referenzlinien mit Ergebnis der Kalibrierung.  

 

  

Dieses beschriftete Spektrum ersetzen 
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Kalibrierung eines 1200L/mm-DADOS-Spektrums des  

Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

➔ 01: Relco SC480 NeArH-Referenzspektrum aktivieren 

 Profile Properties ➔ Y-Axis ➔ Automatic Scaling 500% ➔ Apply ➔  Ok  

 

➔  Enter Line Calibration Mode                             

 

➔ Erste Referenzline 5852.488Å eng eingrenzen 

 

➔ Element filter: RELCO 

 

➔ Ne  – 5852.488 wählen 
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Kalibrierung eines 1200L/mm-DADOS-Spektrums des  

Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

 

 

➔ Add Another Point 

 

➔ Referenzline eng eingrenzen: 5944.834Å 

➔ Ne – 5944.834 wählen 
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Kalibrierung eines 1200L/mm-DADOS-Spektrums des  

Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

 

➔ Add Another Point 

 

➔ Dritte Referenzline eng eingrenzen: 6074.338Å 

➔ Ne – 6074.338 wählen 
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Kalibrierung eines 1200L/mm-DADOS-Spektrums des  

Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

➔ Add Another Point 

 

➔ Vierte Referenzline eng eingrenzen: 6143.063Å 

➔ Suggest liefert: Ne – 6143.063 

 

 

 

 

➔ Calibration fit umstellen auf 2 Quadratic (Polynom zweiten Grades). Restfehler nun: 0.0238Å 
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Kalibrierung eines 1200L/mm-DADOS-Spektrums des  

Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

➔ Add Another Point 

 

➔ Fünfte Referenzline eng eingrenzen: 6266.495Å 

➔ Suggest schlägt Ne – 6266.495 vor 

➔ Calibration fit umstellen auf 3 Cubic (Polynom dritten Grades). Restfehler nun: 0.0216Å  

http://www.schuelerlabor-astronomie.de/
mailto:Bernd.Koch@astrofoto.de


 

            
 Schülerlabor Astronomie des Carl-Fuhlrott-Gymnasiums, Jung-Stilling-Weg 45, 42349 Wuppertal 
www.schuelerlabor-astronomie.de | Kontakt: Dipl.-Phys. Bernd Koch | Bernd.Koch@astrofoto.de              29 

 

 
Kalibrierung eines 1200L/mm-DADOS-Spektrums des  

Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

 

➔ Add Another Point 

➔ Sechste Referenzline eng eingrenzen: 6382.992Å 

➔ Suggest schlägt Ne – 6382.992 vor 

➔ Restfehler nun: 0.0219Å  
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Kalibrierung eines 1200L/mm-DADOS-Spektrums des  

Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

➔ Add Another Point 

➔ Siebte Referenzline eng eingrenzen: 6506.528Å 

➔ Suggest schlägt Ne – 6506.528 vor 

➔ Calibration fit umstellen auf 4 Polynomial (Polynom vierten Grades). Restfehler nun: 0.024Å  

 

➔ Add Another Point 

➔ Achte Referenzline eng eingrenzen: 6532.882Å 

➔ Suggest schlägt Ne – 6532.882 vor 

➔ Calibration fit mit 4 Polynominal (Polynom vierten Grades). Restfehler nun: 0.026Å  
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Kalibrierung eines 1200L/mm-DADOS-Spektrums des  

Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

 

➔ Add Another Point 

➔ Neunte Referenzline eng eingrenzen: 6598.953Å 

➔ Suggest schlägt Ne – 6532.882 vor 

➔ Restfehler nun: 0.026Å  
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Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

➔ Add Another Point 

➔ 10. Referenzline eng eingrenzen: 6717.043Å 

➔ Suggest schlägt Ne – 6717.043 vor 

➔ Restfehler nun: 0.0248Å 
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Kalibrierung eines 1200L/mm-DADOS-Spektrums des  

Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

➔ Add Another Point 

➔ 11. Referenzline eng eingrenzen: 6752.834Å 

➔ Suggest schlägt Ne – 6752.834 vor 

➔ Restfehler nun: 0.029Å 
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Kalibrierung eines 1200L/mm-DADOS-Spektrums des  

Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

➔ Add Another Point 

➔ 12. Referenzline eng eingrenzen: 7147.042Å 

➔ Suggest schlägt Ne – 7147.042 vor 

➔ Polynomgrad 4 

➔ Restfehler: 0.029Å 

 

Für das Spektrum erhält man mit 12 Referenzlinen und einem Polynom 4. Grades einen RMS-Wert 

von 0.02889Å  
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Kalibrierung eines 1200L/mm-DADOS-Spektrums des  

Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

Es ist nicht sinnvoll, hier einen höheren 

Polynomgrad als 4 zu wählen. Der 

Dispersionsverlauf des Spektrografen 

entspricht einer flachen Kurve, die sich 

nur gerinfügig von einer linearen Funktion 

unterscheidet. Die Dispersion beträgt ca. 

1.2Å/px, so dass wir mit einer 

anfänglichen Kalibriergenauigkeit von 

RMS 0.029 Å/px zwischen 5852Å und 

7147Å sehr zufrieden sein können. 

Insbesondere, wenn man den 

überspannten Spektralbereich in Betracht 

zieht. Kleinere Intervalle können mit 

höherer Genauigkeit kalibriert werden. 

Aber wir können probieren, die 

Genauigkeit durch deaktivieren bzw. 

löschen der ungenauesten der 12 Linien 

zu erhöhen. Betrachten wir, wie sich die 

Deaktivierung auf den Bereich um die H-

Linie herum auswirkt. 

Da wir später den Bereich der H-Linie 

ausmessen wollen, interessiert uns dieser 

Bereich besonders. 

 

 

 

 

Seit Version 1.9.8b4 kann man „ungenaue“ Stützpunkte deaktivieren/aktivieren und das Polynom jeweils neu 

berechnen lassen: Man setzt ein Minuszeichen vor die Pixelposition einer Linie, die nicht berücksichtigt werden 

soll. Nun klickt man in eine andere Zeile, was die Neuberechnung auslöst. Mit Löschen des Minuszeichens kann 

die Linie wieder aktiviert werden.   

Man kann nun solange Linien aktivieren und deaktivieren, bis eine befriedigende Genauigkeit entweder im 

Zielbereich H oder über den gesamten Bereich erreicht ist.  

Allerdings sollte man immer das Ziel der Maßnahme im Auge behalten. Wenn man sich auf einen Bereich 

konzentriert, sollte man in dessen Nähe mehr Referenzlinien wählen. 

Die Wellenlängenkalibrierung verbessert sich erheblich auf RMS=0.00976Å.  

➔ Finish 

➔ Speichern 
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Kalibrierung eines 1200L/mm-DADOS-Spektrums des  

Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

10.3 Übertragung der Wellenlängenkalibrierung auf das Spektrum von  VV Cep 
 

➔ 02: VV Cep anwählen 

➔  Profile properties 02: VV Cep  

➔ Use Calibration from first profile 

➔ Copy 

➔ Ok 

➔ Apply 

➔ Ok  

➔   jeweils speichern 

 

 

 

 

 

 

➔ Image Strip View umstellen auf Synth Color stretched (synthetisches Sternspektrum) 

➔  Speichern des Projekts unter dem selben Namen VV Cep.bass 

 

Show/Hide Calibration Points: Schaltet die Anzeige 

der Kalibrierpunkte ein und aus! 
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Kalibrierung eines 1200L/mm-DADOS-Spektrums des  

Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

 

Ausblenden des Referenzspektrums #01 

➔ Rechte Maustaste auf Spektrum #01:  

➔ Spektrum 02:VV Cep mit der Maus aktivieren: 

 

➔  Measurements and Element Lines. Hiermit kann man seine Kalibrierung gezielt an einzelnen 

Linien oder einer ganzen Linienserie überprüfen. Beispiel: Einblenden der H-Ruhewellenlänge.  

➔ Mit Clear entfernt man alle Markierungen wieder.  
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Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

11. Normierung der relativen Intensität des Spektrums 
 

Der Intensitätsverlauf des wellenlängenkalibrierten Spektrums stellt nicht den wahren Kontinuumsverlauf dar. 

Dieser wird durch verschiedene Faktoren verfälscht. Dazu zählt die Instrumentenfunktion („Response“) von 

Teleskop, Spektrograf und Kamera, sowie Absorption und Streuung an interstellarem Staub und Molekülen in 

der Erdatmosphäre. Zusammengefasst spricht man von einem Pseudokontinuum.  

Auf zwei verschiedene Arten können diese Einflüsse beseitigt werden: Normierung auf „1“ oder 

Flusskalibrierung. 

 

11.1 Pseudokontinuum entfernen 
Unter der Normierung eines Spektrums versteht man die Eliminierung des pseudokontinuierlichen Anteils im 

Spektrum (Continuum Removal), so dass nur noch die Spektrallinien im Spektrum verbleiben.  

Subtraktion des Kontinuums: Hat den Nachteil, dass bei einer Subtraktion die relativen Intensitäten der 

Spektrallinien zueinander nicht stimmen. Wird in der Regel nicht angewendet. 

Division durch das Kontinuum: Die relativen Intensitäten bleiben erhalten, das Divisionsergebnis ergibt im 

Spektrum im Idealfall einen exakt horizontalen Verlauf, dessen Intensität den Wert „1“ aufweist. Deshalb 

spricht man auch von der Normierung auf „1“. Dies wird im Folgenden beschrieben. 

1. Durchführung einer Normierung des gesamten Spektrums  

➔ Spektrum 02: VV Cep an Position 1 bringen 

➔ Hide Profile from chart 02: Relco SC480 NeArH  

➔ Spektrum 01: VV Cep ist jetzt aktivieren 

 

➔  Continuum and Response Shaper  

anwenden auf 02: VV Cep 

 

➔ Free Draw wählen 

➔ Kästchen setzen per Doppelklick entlang des Kontinuums.  

 

➔  Refresh aktualisiert das Bild. Kästchen löschen mit 

mittlerer Maustaste. Spektrallinien großzügig überbrücken, 

ohne die Flügel der Linien zu kappen. Die so definierte 

orangene Kurve ist das sogenannte Pseudokontinuum, 

meist auch als Response bezeichnet.  
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➔ Save as Continuum 

Removal for: 01 VV Cep 

 

➔ Normierung direkt 

anwenden: Abfrage mit Ok 

beantworten 
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Kalibrierung eines 1200L/mm-DADOS-Spektrums des  

Spektroskopischen Doppelsterns VV Cephei (M2 Iab / B) 

Ergebnis: Das (vorläufig) normierte Spektrum. 

 

➔ Falls das durchschnittliche Kontinuum in Bereichen NICHT auf einer horizontalen Linie liegt, kann das 

Pseudokontinuum nochmals editiert werden. 

 

➔      Response ➔ Edit 

 

 

 

 

 

 

 

 

 

➔ Target Profile: 01 VV Cep 

 

➔ Free Draw 

 

 

➔ Neue Kästchen können gesetzt und/oder alte 

entfernt werden. Löschen durch Drücken auf 

Mausrad! 
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➔ Save  

 

 

 

 

 

 

 

 

 

➔ Ok 

 

➔  Projekt zwischendurch immer mal speichern:  VV Cep.bass 

 

 

 

Ansicht Vorher/Nachher: Wie sieht das Profil mit bzw. ohne Kontinuumsbeseitigung aus?  

 

➔  Profile Properties  

 

➔ Response 

 

➔ Continuum Removal  No Response Correction 

 

➔ Jeweils Apply 
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11.2 Normierung auf „1“ 
„Normierung auf 1“ bedeutet, dass das Kontinuum auf den Wert 1 festgelegt wird.  

Zunächst sicherstellen, dass das Spektrum von VV Cep an Position 1 steht: 01: VV Cep  

➔ Falls nicht, mit rechter Maustaste in das VV Cep Spektrum klicken 

➔ Sequence 

➔ 01 auswählen 

 

Falls links und rechts unerwünschte Bereiche sind, diese nun ausgrenzen. Ein vollständiges Entfernen aus 

dem Datensatz ist in dieser späten Phase aber nicht mehr möglich: 

 

➔ Mit der linken Maustaste das Spektrum wie gewünscht eingrenzen 

➔  Crop X-Axis Range 

➔ Wellenlängenbereich eingrenzen mit der Maus. 

➔ Apply 

➔   File ➔ Save Project File 

 

Normierung auf „1“ durchführen: 

 

➔ Image  

➔ Normalize Flux Scale 

➔ Im Spektrum einen Bereich definieren, der den Wert 1 erreichen soll. Hier bei ca. 6500Å-6500Å 

➔ Falls unzufrieden mit der Lage der „1“-Linie, neue Start- oder Endwerte eingeben und Apply drücken. 

➔ Falls zufrieden: Close 

 

Hinweis: Die Normierung 

auf „1“ ist ein höchst 

subjektiver Vorgang, der 

von jedem Bearbeiter mit 

einem anderen Ergebnis 

durchgeführt und 

beurteilt wird. Dies kann 

später zu einer Streuung 

der Messwerte führen. 
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11.3 Manuelle Skalierung der Y-Achse (Flux, relative Intensität) 
Die manuelle Skalierung der Y-Achse (Flux) des Spektrums von  Cas beträgt in diesem Beispiel 0 bis 4:  

 

Skalierung der Y-Achse 

 

➔   Profile Properties 

 

➔   Save Property Settings 

 

➔ Apply 

 

➔ Ok 

 

 

 

 

 

 

Ergebnis: Das auf „1“ normierte Sonnenspektrum, in der Intensität von 0 bis 4 skaliert. Das Referenzspektrum 

bleibt ausgeblendet. 

 

➔   File ➔ Save Project File 
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11.4 Durchführung einer genaueren Normierung in der Umgebung von H  
Die Normierung über den gesamten registrierten Spektralbereich von 5800Å bis 7300Å ist nicht präzise 

genug in der Umgebung der H-Linie, die im weiteren Verlauf der Auswertung vermessen werden soll.  

Deshalb konzentrieren wir uns nun auf den Bereich 6500Å bis 6630Å.  

Zunächst speichern wir das bisherige Ergebnis unter einem neuen Namen ab: VV Cep Halpha.bass 

 

 

 

➔ Deaktivieren der vorhandenen Normierung 

 

 

 

➔  Crop X-Axis Range 6500Å-6630Å 
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➔ Y-Achse skalieren von 0 bis 2 

 

➔  Continuum and Response Shaper  

anwenden auf 01: VV Cep 

 

➔ Free Draw wählen 

 

➔ Kästchen setzen per Doppelklick entlang des Kontinuums.  

 

➔  Refresh aktualisiert das Bild. Kästchen löschen mit mittlerer Maustaste. Spektrallinien großzügig 

überbrücken, ohne die Flügel der Linien zu kappen. Die so definierte orangene Kurve ist die sogenannte 

Instrumentenfunktion, meist auch als Response bezeichnet.  
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Normierung auf „1“ 

 

➔ Image ➔ Normalize Flux Scale: 6520Å - 6540Å 

 

 

 

 

 

 

➔ Profile Properties ➔ Manual Scaling: 0.6 bis 4 

 

➔ Die rote “1” Linie wurde nicht mit BASS eingezogen, das 

geht noch nicht. 

 

Fertiges Spektrum: 
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12. Heliozentrische Korrektur und Dopplereffekt 

12.1 Der FITS-Header 
Hinweis: VV Cep ist kein klassischer Be-Stern.  

Stackt man die Spektren in BASS, wird der originale FITS-Header vollständig überschrieben. Möchte man das 

nicht, muss man das Stacking außerhalb von BASS vornehmen. 

Hinweis: Leider überschreibt BASS den ursprünglichen FITS-Header von MaxImM DL, der sehr viel ausführlicher 

ist. 

Hier der von BASS geschriebene FITS-Header: 

➔ Image ➔ FITS Header … 

 

 

 

 

 

Der Eintrag EXPTIME ist das gesamte Zeitintervall in Sekunden zwischen Beginn der ersten und Ende der 

letzten Aufnahme. Es ist nicht die tatsächliche Gesamtbelichtungszeit. 
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12.2 Objekt- und Beobachterdaten eintragen 
 

➔ Tools ➔ Calculate Velocity Correction … 

➔ Calculate Doppler Shift  

➔ Target ➔ Objectname eingeben: VV Cep  

➔ mit Simbad Daten online beschaffen 

 

 

 

 

 

 

       Site (Koordinaten des Beobachtungsorts) 

➔ Site ➔ Latitude ➔ Ok ➔ Longitude ➔ Ok ➔Elevation ➔ Update FITS Header 
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➔ Prüfung des Beobachtungszeitpunktes (exposure mid point) und ggf. Neuberechnung: 

 

 

➔ Calculate ➔ Barycentrische Korrektur wird berechnet 

 

➔ Update FITS Header 

 

Neue Caption: VV Cep 2015-12-31, 17:49:25 UT = JD 2457388.24265 | DADOS 1200L/mm 
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➔ FITS Header prüfen: Die Daten sind eingetragen: 

 

➔ FITS-Header UNBEDINGT SPEICHERN!! 
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Apply Doppler Shift: Doppler Shift hier eintragen und neues, heliozentrisch korrigiertes Profil erzeugen:  

 

 

 

 

 

 

 

Die heliozentrische Korrektur in Höhe von 

-12.222 km/s wird im hier roten Profil 

berücksichtigt. Man erkennt den leichten 

Versatz des Profils.  

Profil #03 ist also das um rund -12 km/s 

verschobene Profil 

 

➔  Profil #03 speichern 

➔ Sonderzeichen entfernen aus dem Pfad:  

➔ vv cep 2015-12-31-17_49_25 ut-jd2457388.24265-dados1200L-VC-12.22279.fit 

➔ Profil #01 Hide Profile from chart 

➔  Projekt speichern VV Cep Halpha.bass 
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➔ Spektrum 03: Farbe ändern auf schwarz 

 

 

Heliozentrisch korrigiertes und normiertes BACHES-Vergleichsspektrum laden: 

 

➔   vvcep_2015_10_11_22_21_55ut_norm_baches_VC0.3798444_helcor.fit 
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Diese vier Spektren sollten derzeit geladen sein: 

 

➔  Projekt speichern als Halpha.bass 

 

➔ DADOS-Spektrum #01 Hide Profile from Chart  

 

➔ DADOS-Spektrum #02 Hide Profile from Chart  

Vergleich: Das BACHES-Spektrum ist mit einer Dispersion von ca. 0.1Å A/px höher aufgelöst als das des 

DADOS mit 0.44 Å/px.  
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Im Versuchsstadium: Kreuzkorrelation zweier 

Spektren (ohne Gewähr) 

Tools ➔ Cross Correlation 

Passwort: C0rrel8 mit Ziffern 0 und 8 
Die Spektren sind mit stark unterschiedlicher 

spektraler Auflösung aufgenommen worden, 

deshalb fällt ein Vergleich schwer.  

Korreliert man beide Spektren, die mit stark 

unterschiedlicher Auflösung gewonnen 

wurden, so verbleibt eine Differenz von 4,16 

km/s.  

Korrelation von Spektrum #03 und Spektrum 

#04 im Interval 6500-6550: -4,16 km/s  
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12.2 Sinnvolle Messgrößen für den DADOS mit Gitter 1200 L/mm 
Folgende Messgrößen können bei der H-Linie ermittelt werden: 

  

 H-Äquivalentbreite in Summe: EW(V+R) von (ca. 6551Å bis 6572Å) 

 Intensität des H V-Peaks 

 Intensität des H R-Peaks 

 V/R-Verhältnis der H−Linie 

 Heliozentrische Radialgeschwindigkeit HRV des H-Absorptionsminimums  

 
Bemerkung: In jedem normierten Profil sind die 

Intensitäten  gespeichert. Zur Darstellung auf dem 

Schirm kann man jedes Profil „einpassen“ ( = 

„Scale as first Profile“) . ANGEZEIGT wird aber 

immer die Skalierung des ersten Profils. Mit der 

Maus erkennt man die korrekten 

Intensitätswerte.  

Hinweis: Im Zuge der bis mindestens Mitte Mai 

2019 laufenden ARAS-Beobachtungskampagne7, 

geleitet von Ernst Pollmann8, tragen Beobachter 

Spektren zum Monitoring von VV Cep bei, die mit 

Spektrografen höherer Auflösung als die des 

DADOS gewonnen wurden. Dies sind überwiegend 

Beiträge des LHIRES III-Spektrografen. 

Auch das CFG Wuppertal beteiligt sich mit 

BACHES-Spektren anlässlich einer Jugend-forscht-

Arbeit an dieser Kampagne. Autoren: Kevin 

Pixberg und Fabian Neußer. Fachliche Beratung: 

Ernst Pollmann. Betreuer: Bernd Koch.  

Hinweis: Zur Teilnahme an der Kampagne ist ein 

spektrales Auflösungsvermögen von R>11000 

erforderlich. Der DADOS erreicht ca. R=4000. Es ist 

jedoch auch mit dem DADOS spannend, das 

Bedeckungsereignis zu verfolgen. In einem 

eigenen Projekt zu VV Cep können mit dem 

DADOS der Gesamt-EW-Wert und das V/R-

Verhältnis ermittelt werden. 

  

 
7 http://www.spectro-aras.com/forum/viewtopic.php?f=19&t=1813 
8 http://astrospectroscopy.de/projects.html 
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12.3 Erfassung der Messgrößen  
Im folgenden wollen wir die definierten Messgrößen erfassen. Für V, R, EW(6551-6572 gelingt das mit BASS, 

aber wir benötigen zur Ermittlung der Teil-EW-Werte (EW(V) und EW (R) eine andere Software: Plot Spectra 

Messung in BASS: 

Da sich in diesem Spektrum die V und die R-Komponente überlagern aufgrund eines nicht ausreichenden 

spektralen Auflösungsvermögens, messen wir die gesamte Äquivalentbreite EW von 6551 bis 6572Å 

➔ Measurements and 

Elements 

➔ Element File: LambdaData.dat 

➔ Measurement Options: Equivalent 

Width 

 

 

 

 

 

 

 

 

➔ Resultat: Equivalent Width EW=-13,74Å.  
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➔ Resultat: Maximaler Fluss V=3.61 

 

➔ Resultat: Maximaler Fluss R=2.46 
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Ergebnisvergleich mit der ARAS-Kampagne: 

 

Zur Erinnerung: Die spektrale Auflösung 

des DADOS mit dem Gitter 1200 L/mm 

beträgt ca. 4000. EW-Werte der 

Teilbereiche V und R können nicht 

gemessen werden, hingegen das V/R-

Verhältnis.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Die senkrechte schwarze Linie gibt den Zeitpunkt dieser DADOS-Beobachtung (31.12.2015) an. Grafik: Ernst 

Pollmann.   

Hinweis: Die Messwerte der ARAS-Kampagne9 wurden mit hoch auflösenden Spektrografen, wie dem LHIRES 

III und dem BACHES mit R>10000 gewonnen und zentral von Ernst Pollmann in einem einheitlichen 

Normierungsverfahren ermittelt. Die in diesem Tutorial durchgefühte Normierung des DADOS-Spektrums des 

Autors muss wegen nicht allgemein festgelegter Messmethoden zwangläufig mit der von Ernst Pollmann  

 
9 ARAS-Forschungskampagne VV-Cephei. Mitwirkende: O. Garde, J. Foster, E. Bertrand, O. Thizy, M. Keiser, J. Guarro, E. 
Pollmann, C. Sawicki, P. Fosanelli, Dong Li, J. Martin, Ch. Kreider, U. Zurmühl, M. Trypsteen, P. Somogyi, V. Desnoux, J. 
Broussat, Th. Lemoult, Th. Griga, B. Koch, F. Neußer, K. Pixberg, M. Schwarz, T. Lester, J. Schirmer. Von 2017 bis 2019. 
url: http: //www.astrosurf.com/aras/. 

Messgröße ARAS-Kampagne 
am 31.12.2015 

DADOS-Messung am 
31.12.2015 

V 4.0 ± 0.5 3.61 

R 2.5 ± 0.5 2.46 

V/R 1.60 1.47 

EW(V) [Å] -7.0 ± 1 nicht messbar 

EW(R) [Å] -5.0 ± 1 nicht messbar 

EW(V)+EW(R) [Å] -12.0 ± 2 -13.7Å 
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übereinstimmen. Ziel ist zu zeigen, dass man den qualitativen der Bedeckung auch mit rel. niedriger Auflösung 

verfolgen kann. Für weitergehende Modellrechnungen sind allerdings nur höher ausgelöste Spektren sinnvoll.  

Die Messung der EW-Werte mit dem DADOS ist bei VV Cep nicht möglich. Aberman kann die Peakhöhen V 

und R bestimmen und das Peakhöhenverhältnis V/R berechnen. 

Der rote Punkt ist eine Messung, die am 13.2.2018 mit dem BACHES Echelle angefertigt wurde und die sich 

in das ARAS-Monitoring nahtlos einfügt. Erkennbar ist eine Periodizität von ca. 43 Tagen. Die Ursache wird in 

einer Nickschwingung der Scheibe des B-Sterns vermutet. Quelle: Ernst Pollmann. Stand: Mitte Februar 2018  

 

13 Beschriftung des normierten Spektrums  
 

➔ H-Ruhewellenlänge 

einzeichnen 
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➔  Label the chart 

➔ Manage Labels 

➔ Speichern 

➔  Projekt speichern 

 

 

 

 

 

 

 

➔ Edit Label 

➔ Speichern 

➔  Projekt speichern 
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14 Notizen erstellen und einblenden 
 

➔  Chart Settings 

 

 

 

 

 

 

 

 

 

 

15. Speichern: Projekt und  1D-Profil 
 

➔   Speichern des Projekts mit allen Skalierungen und Beschriftungen:    VV Cep Halpha.bass 

 

➔  Speichern des Spektralprofils 

(_1D), um es bsp. in VisualSpec oder 

MIDAS zu verarbeiten:  VV Cep_1D.fit 
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16. Übertragung des Projekts an einem anderen Ort („Bundles“) 
BASS arbeitet projektbezogen. Das bedeutet, dass alle für das Projekt benötigten oder erstellten Dateien einen 

festen Pfad besitzen und in einem festen Ordner, hier C:/astrobodger/ … vorhanden sein müssen. Deshalb 

findet diese Kalibrierung von VV Cep gemäß Tutorial ausschließlich im Ordner c:/astrobodger/VV Cep/2015-

12-31 statt.   

Frage: Wie überträgt man die ursprüngliche Kalibrierung .bass von C:/astrobodger/ … auf eine andere 

Festplatte und/oder in einen anderen Ordner, um sie von dort aus aufrufen zu können?  

Antwort: Man öffnet wie gewohnt in c:/astrobodger/VV Cep/2015-12-31 die BASS-Datei (Beispiel: VV Cep 

Halpha.bass und speichert das Projekt im neuen Ordner wie folgt als „Bundle“ ab: 

Speichern als Bundle am neuen Ort:  

➔ File 

➔ Save Project or Bundle 

➔ D:/VV Cep/VV Cep Halpha.bun 

 

Entpacken des Bundles am neuen Ort  

➔ File 

➔ Open Project or Bundle 

➔ D:/VV Cep/VV Cep Halpha.bun  

➔ Dort öffnet man die .bass-Datei des Projekts und arbeitet wie gewohnt weiter. 
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17. Kurse zur Sternspektroskopie am CFG Wuppertal 
Das Tutorials zur Kalibrierung eines Sonne-, bzw. 

Sternspektrums werden in den Kursen des Autors 

(rechts im Bild) am Carl-Fuhlrott-Gymnasium in 

Wuppertal zur Sternspektroskopie eingesetzt. Im 

Rahmen des Kurses wird u.a. das 

Tageslichtspektrum mit insgesamt sieben zur 

Verfügung stehenden DADOS-Spektrografen und 

ebenso vielen STF-8300M CCD-Kameras aufgenom-

men und für die Kalibrierung mit BASS vorbereitet.  

Die seit 2011 verwendete Software VisualSpec wird 

nur noch hin- und wieder herangezogen.  

Aktuelle Kursinformationen finden Sie unter:  

https://www.baader-planetarium.com/de/blog/aktuelle-spektroskopie-kurse-am-schuelerlabor-astronomie/ 
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